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1 Sobre o GIMP

Do site oficial do GIMP (http://gimp.org):

GIMP is an acronym for GNU Image Manipulation Program.
It is a freely distributed program for such tasks as photo retou-
ching, image composition and image authoring.

Além disso, o GIMP possui atualmente uma vasta comunidade de usuários.
Cada vez mais ele representa uma alternativa efetiva aos programas de ma-
nipulação de imagem comerciais. Seus usos variam desde pixel art até elabo-
rad́ıssimas edições e composições de fotos e cenários.

(a) Pixel Art

(b) Concept Art

Figura 1: Imagens feitas no GIMP.
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2 Instalando

O site oficial do GIMP oferece instruções diretas de como instalar o software
na sua máquina de interesse:

http://www.gimp.org/downloads/

O único detalhe é que estamos usando a versão 2.8 (principalmente devido
à funcionalidade Single-Window Mode). Se você usa Windows, então é só usar
o link do site para baixar o instalador. Mas, se você usa Linux, talvez seja
preciso adicionar algum repositório na lista do seu gerenciador de pacotes
caso ele esteja desatualizado. De qualquer maneira, o site explica como lidar
com esse tipo de situação.
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3 Introdução

Como uma introdução ao GIMP, vamos fazer uma edição bem simples. O
objetivo será colorir a imagem de um ı́cone preto-e-branco, como mostrado
na Figura 2. A imagem original está dispońıvel em

http://game-icons.net/lorc/originals/beast-eye.html

O ideal é pegar a versão com maior resolução posśıvel, em PNG.
Com esse exerćıcio esperamos apresentar as funcionalidades básicas e as

técnicas essenciais para se manipular imagens com o GIMP. Mas apesar do
foco nesse momento ser passar os conceitos básicos para o aluno, também in-
troduziremos algumas das principais ferramentas usadas em projetos GIMP.

3.1 Abrindo a imagem e convertendo para RGBA

O primeiro passo do exerćıcio é dizer para o GIMP que queremos trabalhar
em RGBA (isso é, com cores e transparência) ao invés de Grayscale, que é
o formato no qual a imagem do ı́cone está. E vamos aproveitar esse passo
para mostrar o básico de copiar e colar imagens com GIMP (que não é muito
diferente do convencional).

Começamos abrindo a imagem original indo em File → Open ou digi-
tando CTRL+O.

Algo que facilita muito o uso do GIMP é a familiarização com os
atalhos de teclado. Saber uma meia-dúzia de atalhos é o suficiente para
dobrar a eficiência de trabalho.

Do jeito que o GIMP carrega a imagem (em Grayscale) não é posśıvel apli-
car nenhuma cor aos pixeis. Isso significa que se selecionarmos, por exemplo,
a Pencil Tool (atalho N), e mudarmos a cor para vermelho, ainda assim
pintaremos apenas tons de cinza.

Para mudar de cor no GIMP, basta clicar duas vezes no retângulo
colorido no meio da Toolbox , como mostra a Figura 3.
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(a) Antes (b) Depois

Figura 2

Para desfazer uma ação GIMP, pode-se ir em Edit → Undo ou digi-
tar CTRL+Z. É um comando extremamente útil, e o histórico de ações
que o GIMP guarda é bastante grande. Use ele para desfazer quaisquer
alterações que você possa ter feito na imagem original antes de seguir os
próximos passos.

Vamos, então, criar uma nova imagem que use RGBA ao invés de Grays-
cale. Para isso, clicamos em File → New ou digitamos CTRL+N. Um
menu Create a New Image aparecerá. Nele temos acesso à várias confi-
gurações da nova imagem, como a largura e a altura dela. Essas manteremos
como estão (512x512 se você pegou a maior resolução dispońıvel). O que nos
interessa aqui é mudar o formato de cores e o suporte a transparência. Basta
mudar essas configurações conforme a Figura 4.
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Figura 3: Seleciondo a Pencil Tool e mudando a cor.

Figura 4: Criando uma imagem RGBA
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Uma vez feito isso, basta voltarmos para a imagem original, e:

• Selecionarmos ela inteira com Botão Direito do Mouse→ Selection
→ All ou CTRL+A.

• Copiarmos ela com Botão Direito do Mouse → Edit → Copy ou
CTRL+C.

• Voltarmos para a imagem com RGBA que acabamos de criar.

• Colarmos o ı́cone orignal nela com Botão Direito do Mouse→ Edit
→ Paste ou CTRL+V.

3.2 Sobre seleções

Agora que temos nossa imagem pronta para ser manipulada, vamos falar so-
bre seleções no GIMP. Seleções são um conceito primordial para qualquer tipo
de edição, pois toda ferramenta que não seja de seleção, só é aplicada
sobre a seleção atual. Quando não há nenhuma seleção, então a imagem
toda é considerada selecionada (ou seja, as ferramentas serão aplicadas em
todas as partes dela).

Para entender isso melhor, podemos escollher a Rectangle Selection
Tool (atalho R) e selecionar uma região qualquer da imagem clicando e
arrastando o mouse, e depois soltando-o. Agora, se escolhermos, por exemplo,
a Bucket Feel Tool (atalho SHIFT+B) e tentarmos usá-la, obteremos o
resultado mostrado na Figura 5.

Figura 5: As ferramentas trabalham apenas nas regiões selecionadas
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Outras duas ferramentas de seleção que vamos usar bastante são a Free
Select Tool (atalho F) e a Fuzzy Select Tool (atalho U). A primeira
permite selecionar uma região à mão livre e a segunda seleciona uma região
que tenha uma cor em comum. Recomendamos experimentar um pouco com
ela antes de prosseguir. Posśıveis resultados do uso dessas ferramentas podem
ser vistas na Figura 6.

A Free Select Tool também pode ser usada traçando retas. Cada
ponto que você clicar será ligado ao anterior, até que você volte a clicar no
primeiro. Então, a região será selecionada. Também é posśıvel misturar
trechos retos e à mão livre.

Figura 6: Free Select Tool (esquerda) e Fuzzy Select Tool (direita).

Agora, vamos afazer algo mais útil. Vamos colorir a pupila do olho na
imagem. Como é de se esperar, para isso precisamos selecionar a pupila.
A primeira ideia é usar a Fuzzy Selection Tool e clicar nas regiões que
correspondem à pupila. No entanto, como nas bordas dessa região há uma
transição do branco para o preto, a seleção não fica perfeita (partes da borda
ficam de fora). Além disso, mesmo que selecionássemos um dos lados da
pupila, como selecionar o outro ao mesmo tempo?

É nesse ponto que entram as operações de seleção. Começando pelo
primeiro problema, o grande obstáculo é que a Fuzzy Selection Tool não
alcança todas as partes da região branca, isso é, fica faltando pixels na região
selecionada e sobrando na região não selecionada. Por outro lado, o mesmo
acontece se a usamos para selecionar a região preta. Então uma plauśıvel
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Figura 7: O objetivo é selecionar apenas a pupila para podermos manipulá-la sem correr
o risco de ”vazar”para as outras partes da imagem

solução seria pegarmos o inverso da região preta. A operação de inversão
é a primeira das operações de seleção, e pode ser realizada usando Botão
Direito do Mouse → Select → Invert ou CTRL+I.

Mas então temos outro problema: todas as regiões brancas ficaram se-
lecionadas. Para resolver isso usamos a operação de intersecção ou a
operação de diferença. Diferentemente da operação de inversão, essas
operações são aplicadas com o aux́ılio de alguma ferramenta de seleção. No
caso, vamos usar a Free Select Tool.

Para ativar a operação de intersecçao, basta segurar CTRL+SHIFT
e usar a ferramenta de seleção. Quando terminar, todas as regiões em
comum entre a região até então selecionada e a nova comporão a nova
seleção.

Para ativar a operação de diferença, deve-se segurar CTRL e usar a fer-
ramenta de seleção. No final, as novas regiões selecionadas serão subtráıdas
da seleção antiga.

A última operação de seleção é a operação de soma. Ela é ativada
segurando SHIFT antes de usar uma ferramenta de seleção, e a nova
região selecionada é somada à que havia antes.
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Figura 8: Muda-se o pincel (brush) usado por uma ferramenta de manipulação na região
destacada.

Quando, enfim, a pupila estiver devidamente selecionada, use alguma
ferramenta de manipulação para deixá-la como preferir. No nosso exemplo,
usamos a Airbrush Tool. Ajustamos o formato do pincel dela na opção
indicada na Figura 8, e aumentamos seu tamanho até ficar do tamanho da
pupila. Por fim, aplicamos ela no centro da pupila (que, em particular, não
está na região selecionada) e obtivemos o resultado da Figura 7.

Para diminuir ou aumentar o tamanho de uma ferramenta de mani-
pulação, usa-se os botões [ e ], respectivamente.

3.3 Sobre camadas

Uma dificuldade comum quando se começa a usar o GIMP é saber como
mover seleções. Quando tentamos mover uma região selecionada usando a
Move Tool, por exemplo, apenas o contorno da região se move, e não o
conteúdo dela. Para fazer isso, é preciso recortar e logo em seguida colar de
volta a região selecionada. Só então é que a região junto com seu conteúdo
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poderá ser movida.

Para recortar podemos usar Botão Direito do Mouse → Edit →
Cut ou o atalho CTRL+X.

Na verdade, o que acontece é que quando colamos algo no GIMP, uma
nova camada é criada usando a seleção colada. E, assim, quando movemos a
seleção, estamos realmente é movendo a nova camada. Quando confirmamos
a colagem (clicando fora da seleção, normalmente), essa camada temporária
criada pelo GIMP é aplicada na original. Ela recebe o nome de Floating
Selection enquanto estiver nesse estado intermediário, como mostra a figura
9.

Mas qual a utilidade das camadas? Assim como com as seleções, as
ferramentas de edição do GIMP são aplicadas apenas na camada
atualmente selecionada. Ou seja, no final das contas as ferramentas
de edição só funcionam na seleção atual da camada focada. Mas as
camadas, diferentemente de simples seleções, têm a vantagem de persistirem
ao longo do projeto. Você pode dividir seu trabalho em camadas, e trabalhar
separadamente em cada uma sem que haja interferência entre elas. Sempre
que quiser voltar a mexer em uma delas basta selecioná-la no menu Layers.

Figura 9: Seleções coladas ficam em uma camada flutuante temporária

13



Então, voltando ao nosso exerćıcio, vamos selecionar o olho inteiro e se-
pará-lo em uma camada diferente do resto. Para isso, vamos nos aproveitar
do mecanismo de recortar e colar que acabamos de ver. Usando as ferramen-
tas de seleção Free e Fuzzy, junto com as operações de seleção, selecionamos
o olho e o recortamos, para depois colar de volta. Só que ao invés de sim-
plesmente confirmamos a colagem, vamos usar Botão Direito do Mouse
→ To New Layer sobre a camada flutuante no menu de camadas. Isso irá
de fato isolar a seleção em uma nova camada, como queremos.

Mas a nova camada criada estará com um nome parecido com Pasted
Layer ou algo assim. Para mudar isso, basta selecioná-la no menu de ca-
madas e usar Botão Direito do Mouse → Edit Layer Attributes ou
apertar o botão F2. Podemos renomear a camada do olho para ”Eye”, por
exemplo. Eventualmente, se quisermos remover uma camada, é só clicar
nela e usar Botão Direito do Mouse → Delete Layer (note que pressio-
nar DELETE terá um efeito completamente diferente: ele irá apagar todo
o conteúdo da camada, deixando apenas pixeis transparentes ou da cor de
fundo, dependendo do tipo da imagem).

Além disso, como é posśıvel perceber, o GIMP apresenta as camadas de
baixo para cima, isso é, as camadas de cima aparecem por cima das camadas
de baixo. É posśıvel alterar essa ordem clicando e arrastando elas no menu
de camadas. Também é posśıvel ocultar uma camada clicando no ı́cone de
olho do lado esquerdo do nome delas (vide Figura 10).

Figura 10: Podemos esconder uma camada clicando no ı́cone destacado

É importante ressaltar que quando exportamos um trabalho para, di-
gamos, uma imagem PNG, a imagem final será uma sobreposição apenas
das camadas viśıveis (as ocultas não aparecerão).

Outro detalhe de criar camadas recortando e colando é que a nova ca-
mada acaba tendo um tamanho menor que a orignal. Esse tamanho pode
ser reconhecido por uma linha pontilhada preta e amarela em volta da região
que delimita a camada. Para ajustar ela de volta para o tamanho total da
imagem, usa-se Botão Direito do Mouse → Layer to Image Size.
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Mas agora a camada de baixo (provavelmente chamada de beast-eye.png)
ficou com um espaço vazio onde o olho ficava. Podemos facilmente preencher
ele de preto usando a Bucket Fill Tool mencionada mais cedo. Vamos
aproveitar para renomear essa camada para ”Background”ou algo semelhante
que faça sentido. Depois, vamos repetir o processo de criar uma nova camada
para as estrias do desenho, e chamemos essa terceira camada de algo como
”Stripes”. No final, o esquema de camadas deve estar condizente com a
Figura 11.

Figura 11: As três camadas no final

3.4 Finalizando

Bom, agora que a imagem está devidamente separada em camadas, falta ape-
nas coloŕı-las apropriadamente. Podemos pintar as estrias com uma única
cor usando a técnica de inverter a seleção do fundo pela Fuzzy Selection Tool
e depois aplicar a Bucket Fill Tool sobre as regiões selecionadas resultan-
tes. Podeŕıamos usar qualquer outra ferramenta de edição além da Bucket,
mas por simplicidade vamos continuar usando ela de exemplo. Nesse ponto,
teremos algo parecido com o que aparece na Figura 12.

Vamos, por fim, colorir o fundo. Nesse caso, como queremos preencher
toda a camada em questão, não precisamos nos preocupar com seleções. Mais
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Figura 12: Resultado quase pronto da edição

uma vez usaremos a ferramente Bucket, mas agora com uma textura ao invés
de uma simples cor plana. Para tanto, selecionamos a opção Pattern Fill no
menu da ferramenta Bucket (metade de baixo do menu Toolbox) e mudamos
a textura desejada para Leather, por exemplo. Esse passos estão expostos na
Figura 13.

Figura 13: Ajustando a ferramenta Bucket para usar a textura Leather

Agora é só aplicar a ferramenta Bucket na camada de fundo! Com isso
chegamos ao resultado final mostrado no começo da introdução, mostrado
na Figura 14. Mas um dos problemas da imagem do jeito que ela ficou é
que ela está muito plana. É posśıvel usar diversas ferramentas de edição
para melhorar isso. O leitor pode consultar a seção de ferramentas em busca
da que achar melhor, mas sugerimos a Dodge/Burn Tool para efeitos de
luz e sombra, por exemplo. Também vale a pena uma olhada na seção 4.3
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(Controle de Cor).
Também serve como um treino interessante repetir esse exerćıcio usando

ferramentas de edição diferentes e usando a própria criatividade. Por exem-
plo, poder-se-ia fazer uma pupila com efeitos mais interessantes. Muitas
outras imagens semelhantes à usada podem ser encontradas e usadas gratui-
tamente do site:

http://game-icons.net/

Contanto que seja dado o devido crédito ao autor.
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Figura 14: Resultado final
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4 Ferramentas

4.1 Seleção

4.1.1 Retângulo

(Atalho R)

Essa ferramenta seleciona uma área retângular.
Para usá-la, basta selecionar um ponto, clicar e ar-
rastar.

4.1.2 Elipse

(Atalho E)

Essa ferramenta seleciona uma área eĺıptica. Para
usá-la, basta selecionar um ponto, clicar e arrastar.

4.1.3 Livre

(Atalho F)

Essa ferramenta seleciona uma área definida pelo
usuário, sem ajustes. Para usá-la, basta selecionar
um ponto, clicar e arrastar.

4.1.4 Tesoura

(Atalho I)

Essa ferramenta seleciona uma área definida pelo
usuário, mas tentando separar áreas pela diferença
de cores. Para usá-la, clique num ponto inicial, e em
seguida clique nos pŕoximos pontos que contornam
a área que você quer selecionar. Caso você queira
mudar a seleção feita pelo GIMP, você pode clicar
na borda da área selecionada e arrastar para onde
ela deveria estar.

4.1.5 Fuzzy

(Atalho U)

Essa ferramenta seleciona uma área de cores seme-
lhantes a uma área clicada inicialmente. A sensi-
tividade da seleção pode ser alterada mantendo o
botão do mouse pressionado e movendo o mouse.
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4.1.6 Cor

(Atalho Shift + O)

Essa ferramenta é parecida com a ferramente de
seleção fuzzy, mas ela seleciona todas as áreas com
cores semelhantes à área clicada. A sensitividade da
seleção pode ser alterada do mesmo modo.

4.2 Edição

4.2.1 Blur

(Atalho Shift + U)

O blur suaviza a área afetada, dando uma impressão
de embaçamento.

4.2.2 Bucket Fill

(Atalho Shift + B)

O bucket fill preenche toda uma área de uma deter-
minada cor com outra cor.

4.2.3 Clone

(Atalho C)

A ferramenta clone copia uma área origem da ima-
gem em outra área destino da imagem.

4.2.4 Heal

(Atalho H)

A ferramente heal é parecida com a clone, mas a
imagem é copiada de maneira mais suave.

4.2.5 Color Picker

(Atalho O)

Essa ferramenta seleciona a cor do pixel clicado. Se
você segurar CTRL ao usar ferramentas como Pen-
cil ou Paintbrush, você automaticamente trocará
para o Color Picker.
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4.2.6 Dodge

(Atalho Shift + D)

Essa ferramenta clareia ou escurece a área afetada.
Para escurecer, segure shift ao clicar.

4.2.7 Eraser

(Atalho Shift + E)

Essa ferramenta apaga a área afetada. Se a camada
possui um canal alpha, a parte apagada ficará trans-
parente. Caso contrário, ficará da cor secundária.

4.2.8 Move

(Atalho M)

Move a imagem, camada atual ou área de seleção.
Note que, se estiver no modo de mover área de
seleção, ele move a área de seleção em si, não a área
selecionada.

4.2.9 Paintbrush

(Atalho P)

Pinta suavemente da cor escolhida. O estilo do pin-
cel pode ser escolhido.

4.2.10 Pencil

(Atalho N)
Pinta toda a área do pincel, sem suavizações.

4.2.11 Rotate

(Atalho Shift + R)
Rotaciona a área selecionada.

4.2.12 Scale

(Atalho Shift + T)
Altera o tamanho da área selecionada.

4.2.13 Smudge

(Atalho S)

Borra a área afetada, de maneira semelhante a
alguém passando o dedo por cima.
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4.2.14 Text

(Atalho T)
Insere um texto na imagem.

4.3 Controle de Cor

Muitas vezes queremos apenas mudar as cores de uma imagem, e ter que edi-
tar manualmente seria exaustivo senão inviável. Por exemplo, se quisermos
passar parte de uma imagem colorida para tons de cinza, podemos usar tanto
a opção Hue-Saturation como a Colorize para retirar toda a saturação da
imagem.

Além do formato usual de representação de cores RGB, também é
posśıvel existe o Hue-Saturaion-Lightness, que em geral é mais fácil e
mais intuitivo de usar. Como o próprio nome indica, você escolhe valores
de matiz, saturação e luminosidade da cor.

Essas opções podem ser encontradas no menu Colors. Nessa apostila,
explicamos apenas as quatro primeiras, que são as mais simples e mais úteis
de maneira geral.

Assim como as ferramentas, essas opções são aplicadas sobre a seleção
atual, ou sobre a camada inteira se não houver seleção. Por padrão elas
mostram uma prévia do resultado na imagem, mas suas modificações só são
efetivadas quando o botão OK delas é pressionado.

4.3.1 Color Balance

Essa opção permite que você manipule a proporção das cores, alterando o
balanço entre as partes complementares. Você pode, por exemplo, aumentar
a proporção de amarelo diminuindo a parte azul, e toda a região afetada
ficará mais amarelada.
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Figura 15: Menu de controle de balanço de cores.

No entanto, a opção atinge apenas certos intervalos de cores. Como pode
ser visto na Figura 15, você pode escolher qual intervalo afetar dentre som-
bras, tons médios e iluminações.

Essa opção pode ser usada para ajustar os tons das cores de imagens. Por
exemplo, é posśıvel manipular a iluminação em uma foto de forma a fazer
parecer que a luz no local é de uma cor diferente da original.

4.3.2 Hue-Saturation

Essa opção permite que você manipule os valores de Hue-Saturation-Lightness
da imagem, ou de alguns tons da imagem. Você pode, por exemplo, tirar
toda a saturação dos tons de vermelho de uma imagem, deixando-os apenas
com tons de cinza. Ou você pode mudar todos os tons de amarelo para verde,
também.
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Figura 16: Menu de controle de matiz, saturação de luminosidade.

O principal propósito dessa opção é fazer ajustes nos tons de cor para se
alcançar a saturação, a matiz e a iluminação desejadas.

4.3.3 Colorize

Essa opção lembra bastante a opção Hue-Saturation, mas ao invés de mani-
pular os valores Hue-Saturation-Lightness originais da imagem, ela sobrepõe
completamente eles. Isso significa que se você usar essa opção para mover a
matiz para azul, toda a região afetada terá a matiz azul. O mesmo vale para
a saturação e para a limnunosidade.
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Figura 17: Menu de controle de colorização.

O principal objetivo dessa ferramenta é atribuir diretamente valores de
saturação, matiz e luminosidade em determinadas regiões da imagem.

4.3.4 Brightness-Contrast

Essa opção permite que você ajuste o brilho e o contraste da imagem, da
mesma maneira que fazemos com monitores e projetores. Você pode, por
exemplo, aumentar o brilho e o contraste de uma imagem escura e embaçada
para tentar discernir melhor os elementos dela.
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Figura 18: Menu de controle de brilho e contraste.

O principal objetivo dessa ferramenta é ajustar o brilho e o contraste da
região afetada para melhorar a visibilidade da imagem.
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5 Créditos

• Figura 1a
Fonte:

[LPC] 2 Characters (modificado)
http://game-icons.net/lorc/original/beast-eye.html

Autores: pennomi, laetissima, makrohn e artistas dos sprites base LPC.
Licensa: CC3.0 - By

• Figura 1b
Fonte:

Dance of Rebirth
http://opengameart.org/content/dance-of-rebirth

Autor: 5shiroi
Licensa: CC0

• Figura 2a
Fonte:

Game Icons
http://game-icons.net/lorc/original/beast-eye.html

Autor: Lorc
Licensa: CC3.0 - By
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